
完璧なAnalytics-Con-301問題無料 &資格試験のリー
ダープロバイダー &唯一無二Analytics-Con-301試験勉
強攻略

無料でクラウドストレージから最新のJapancert Analytics-Con-301 PDFダンプをダウンロードす
る：https://drive.google.com/open?id=1aeA_ROQDuOl8L-pwpoQvMRFyJhpXb9Na

たくさんの人はSalesforce Analytics-Con-301「Salesforce Certified Tableau Consultant」認証試験を通ることが難しいと
思います。もし弊社の問題集を勉強してそれは簡単になります。弊社はオンラインサービスとアフターサービ
スとオンラインなどの全面方面を含めてます。オンラインサービスは研究資料模擬练習問題などで、アフター
サービスはJapancertが最新の認定問題だけでなく、絶えずに問題集を更新しています。

Salesforce Analytics-Con-301 認定試験の出題範囲：

トピック 出題範囲

トピック 1

IT管 ​​理：この領域では、Tableau環境の管理に関連するスキルを測定します。サーバーアッ
プグレードの計画、導入ソリューション（オンプレミスまたはクラウド）の推奨、分析イ
ンフラストラクチャに関する技術要件とビジネス要件の整合性確保などが含まれます。ま
た、Tableau Serverおよびクラウド導入に関連するシステムパフォーマンスのトラブル
シューティングと最適化も含まれます。

トピック 2

ビジネスコンサルティング：Tableauコンサルタント向けのこのセクションでは、高度な分
析ユースケースに対応するための計算とワークブックの設計とトラブルシューティングを
行います。適切なチャートタイプの選択、計算におけるTableauの演算順序の適用、ダッ
シュボードへのインタラクティブ機能の組み込み、リソースを大量に消費するクエリやそ
の他の設計関連の問題の解決によるワークブックのパフォーマンスの最適化などについて
扱います。
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トピック 3

データビジュアライゼーション：このセクションでは、Tableauコンサルタントが効果的な
ビジュアル分析ソリューションを設計する能力を評価します。これには、ユーザーの理解
を深めるダッシュボードやビジュアルレポートの作成、動的なアクションや高度なチャー
トタイプなどの手法の活用、そしてインタラクティブなユーザーエクスペリエンスのため
のパフォーマンス最適化の確保が含まれます。

トピック 4

ビジネス分析：このセクションでは、Tableauコンサルタントのスキルを評価し、組織内の
分析環境の現状評価に焦点を当てます。ビジネスニーズとTableauの機能とのマッピング、
分析要件をTableauのベストプラクティスに落とし込む方法、そしてTableau ServerやTableau
Cloudといった適切な導入オプションの推奨といった内容が含まれます。また、ビジネス
ニーズをサポートするための既存のデータ構造の評価、パフォーマンスリスクと機会の特
定も含まれます。

トピック 5

データ管理：このパートでは、パブリッシュされたコンテンツのガバナンスとサポートの
確立に焦点を当てます。Tableauコンサルタントは、データセキュリティの管理、データ
ソースとワークブックのパブリッシュと維持、コンテンツへのアクセス監視を行うことが
求められます。これには、ガバナンスのベストプラクティスの適用、メタデータAPIの使
用、データの整合性とアクセシビリティを維持するための管理機能のサポートが含まれま
す。

>> Analytics-Con-301問題無料  <<

検証する-素敵なAnalytics-Con-301問題無料試験-試験の準備方法
Analytics-Con-301試験勉強攻略

当社のAnalytics-Con-301実践教材は一流の専門家によって編集され、Analytics-Con-301スタディガイドは思いやり
のあるサービスとアクセス可能なコンテンツのパッケージ全体を提供します。 さらに、Analytics-Con-301 Actual
Testは、さまざまな側面で効率を改善します。 専門的な知識を十分に身に付けることは、あなたの人生に大い
に役立ちます。 知識の時代の到来により、私たちはすべて、Analytics-Con-301などの専門的な証明書を必要とし
ています。

Salesforce Certified Tableau Consultant 認定 Analytics-Con-301 試験問題
(Q26-Q31):
質問  # 26 
A multi-national company wants to have a Tableau dashboard that will provide country-level information for both its forecast
summaries and year-on-year metrics. The company wants to toggle between these two views while leaving main key performance
indicators (KPIs) visible on the main dashboard.
Which method is the most efficient in achieving the company's requirements?

A. Create a single worksheet with all the measures required for both the forecast summary and the year-on- year views.
. Create a Boolean parameter and a corresponding calculated field with the following calculation: True.
. Add a blank dashboard object and in the Layout tab, check the box for "Control visibility using value" and select the
parameter you created.
B. Create a parameter that accepts values from a list that contains "Forecast View" and "Year-on-Year View."
. Right-click the parameter and select Add to Sheet for both worksheets.
. Navigate back to the dashboard and to the upper corner of the two worksheets.
. Enable the Use as Filter option.
C. Create a Boolean parameter with the two names of the views as aliases and a corresponding calculated field with the
following calculation: True.
. Add the forecast summary sheet to the dashboard and add the year-on-year metrics sheet to the same dashboard as a
Floating dashboard object.
. Add the calculated fields as a Detail under the Marks card of the floating view, create a "Change Parameter" action, and set
the
"Target Parameter" and "Source Fields" to the parameter and calculated field you created.
. Check the box for "Control visibility using value" in the Layout tab of the floating view and select the parameter you created.
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D. Create a dashboard with the sheets containing the main KPIs and the forecast summary worksheet.
. Duplicate this dashboard and replace the forecast view worksheet with the year-on-year metrics worksheet.
. Add navigation buttons to both dashboards.

正解：C

解説：
The most efficient method for toggling between two views (forecast summaries and year-on-year metrics) while keeping main KPIs
visible involves using a parameter and calculated fields for controlling visibility:
* Create a Boolean Parameter: This parameter will have two aliases representing the two views ("Forecast View" and "Year-on-
Year View"). This allows the user to select which view they wish to see directly from the dashboard.
* Calculated Field: Create a calculated field that always returns True. This field acts as a constant placeholder to enable the visibility
control tied to the parameter.
* Dashboard Setup: Place both the forecast summary and the year-on-year metrics sheets on the dashboard. Set the year-on-year
metrics sheet as a floating object over the forecast summary.
* Visibility Control: Use the "Control visibility using value" option in the Layout tab for the floating year-on-year metrics view. Tie
this setting to the Boolean parameter so that changing the parameter will show or hide this view without affecting the main KPIs
displayed on the dashboard.
* Interactivity: Implement a "Change Parameter" dashboard action where selecting different options in the dashboard (e.g., clicking
on certain parts) triggers the parameter to change, thus toggling the visible view.
References
This method leverages Tableau's dashboard interactivity features including parameters, calculated fields, and visibility settings, as
recommended in Tableau's user guide on dynamic dashboard design.

質問  # 27 
A client has a pipeline dashboard that takes a long time to load. The dashboard is connected to only one large data source that is an
extract.
It contains two calculated fields:
. TOTAL([Opportunities])
* SUM([Value])
It also contains two filters:
. A Relative Date filter on Created Date, a Date field containing values from 5 years ago until today
. A Multiple Values (Dropdown) filter on Account Name, a String field containing 1,000 distinct values A consultant creates a
Performance Recording to troubleshoot the issue, and finds out that the longest-running event is "Executing Query." Which step
should the consultant take to resolve this issue?

A. Replace the TOTAL([Opportunities]) calculation with a Grand Total.
B. Replace the Relative Date filter with a Multiple Values (Dropdown) filter on YEAR([Created Date]).
C. Replace SUM([Value]) with WINDOW_SUM([Value]).
D. Replace the Multiple Values (Dropdown) filter with a Multiple Values (Custom List) filter.

正解：B

解説：
To improve the loading time of the pipeline dashboard, which primarily suffers from long query execution times due to a
comprehensive Relative Date filter:
Relative Date Filter Issue: The existing Relative Date filter on "Created Date" covers a broad range (5 years), leading to significant
data processing overhead as it includes granular date calculations over a large dataset.
Optimized Approach: By replacing the Relative Date filter with a Multiple Values (Dropdown) filter based on YEAR([Created
Date]), the filter granularity is reduced. Filtering by year simplifies the query by limiting the volume of data processed and reducing
the complexity of the filter condition.
Implementation Benefit: This approach still provides the flexibility to view data across different years but does so by reducing the
load on the database during query execution, which is critical for improving the performance of the dashboard.
References
This recommendation aligns with Tableau performance optimization strategies, specifically regarding the management of date filters to
minimize their impact on query load, as discussed in Tableau performance tuning sessions and guides.

質問  # 28 
SIMULATION



From the desktop, open the CC workbook.
Open the City Pareto worksheet.
You need to complete the Pareto chart to show the percentage of sales compared to the percentage of cities. The chart must show
references lines to visualize how the data compares to the Pareto principle.
From the File menu in Tableau Desktop, click Save.

正解：

解説：
See the complete Steps below in Explanation
Explanation:
To complete the Pareto chart in the "City Pareto" worksheet of your Tableau Desktop and add reference lines to illustrate how the
data compares to the Pareto principle, follow these steps:
Open the CC Workbook and Access the Worksheet:
From the desktop, double-click on the CC workbook to open it in Tableau Desktop.
Navigate to the City Pareto worksheet by selecting its tab at the bottom of the window.
Construct the Pareto Chart:
Ensure that sales data is aggregated by city. If not, drag the 'City' dimension to the Columns shelf and the 'Sales' measure to the
Rows shelf.
Sort the sales data in descending order to properly align the cities according to their sales contribution.
To create a running total of sales, right-click on the 'Sales' measure on the Rows shelf, select 'Quick Table Calculation', and choose
'Running Total'.
Drag the 'Number of Records' field to the Rows shelf next to the Sales running total. Right-click on it, select 'Quick Table
Calculation', and choose 'Running Total'. Set its calculation to 'Percent of Total' from the 'Edit Table Calculation' option to represent
the percentage of cities.
Add Reference Lines for the Pareto Principle:
Click on the Analytics tab in the sidebar.
Drag a 'Reference Line' element and drop it onto the chart area.
Set the Reference Line for the Sales axis at 80% to represent the typical Pareto cutoff where 80% of effects come from 20% of
causes.
Add another Reference Line on the axis representing the percentage of cities, set at 20%, to visually assess the Pareto principle.
Adjust the Appearance of the Chart:
Format the reference lines by right-clicking on them, selecting 'Edit', and choosing a distinct style or color to make them stand out.
Ensure the chart is clear and labels are appropriately adjusted for easy understanding of the data visualization.
Save Your Changes:
From the File menu, click 'Save' to ensure all your changes are stored.
References:
Tableau Help: Offers detailed guidance on creating Pareto charts and adding reference lines.
Tableau Visualization Best Practices: Provides tips on effectively displaying cumulative data and principles such as Pareto.
By following these steps, you will have successfully enhanced the City Pareto worksheet to include a complete Pareto chart with
reference lines that illustrate how the sales data compares to the Pareto principle, making it easier to analyze and communicate the
distribution of sales across cities.

質問  # 29 
A client's dashboard has two sections dedicated to their shops and warehouses shown when a viewer chooses either shops or
warehouses with a parameter.
There are a few quick filters that apply to both, while others apply to only shops or only warehouses.
Currently, the quick filters are all shown at the left side of the dashboard. The client wants to hide all filters, but when shown, make it
easy for the viewer to find the quick filters that work for only shops or only warehouses.
Which solution should the consultant recommend that meets the client's needs and is most user-friendly?

A. Hide container with all quick filters with a Show/Hide Button.
B. Use Dynamic Zone Visibility to inform viewers which quick filters apply to warehouses or shops.
C. Divide the quick filters into three groups: General, for shops. Place the general filters on the left of dashboard for
warehouses. Place other filters next to the sections to which they apply.
D. Use Dynamic Zone Visibility to show only the quick filters that apply with the chosen parameter value and a Show/Hide
Button to hide container with all the filters.

正解：D



解説：
The most user-friendly solution is to use Dynamic Zone Visibility in combination with a Show/Hide Button. This approach allows the
dashboard to dynamically display only the relevant quick filters based on the viewer's selection of shops or warehouses, thus
reducing clutter and focusing the user's attention on applicable filters. The Show/Hide Button further enhances the user experience by
allowing viewers to toggle the visibility of the filter container, providing a clean and organized dashboard interface1.
References: Dynamic Zone Visibility is a feature in Tableau that enables dashboard elements to appear or disappear based on the
value of a field or parameter1. This functionality is ideal for creating interactive and user-friendly dashboards that adapt to user
interactions and selections1.

質問  # 30 
A consultant used Tableau Data Catalog to determine which workbooks will be affected by a field change.
Catalog shows:
* Published Data Source # 7 connected workbooks
* Field search (Lineage tab) # 6 impacted workbooks
The client asks: Why 7 connected, but only 6 impacted?

A. The field being altered is not used in the seventh workbook.
B. The seventh workbook is connected via Custom SQL so it didn't appear in the list.
C. The consultant lacked sufficient permissions to see the seventh workbook.
D. The field is used twice in a single workbook.

正解：A

解説：
Comprehensive and Detailed Explanation From Exact Extract:
Key Tableau Catalog behaviors:
* Connected workbooks = any workbook linked to the published data source.
* Impacted workbooks = only workbooks that use the specific field.
* If a workbook connects to the data source but never uses the field, it appears as "connected" but not impacted.
This explains EXACTLY why:
* 7 workbooks are connected
* Only 6 use the changed field
* Therefore only 6 are impacted
This matches Option C.
Why the other options are incorrect:
A). Field used twice
Still counts as one workbook - does not explain discrepancy.
B). Permission issue
If permissions blocked visibility, the data source would not list 7 connections.
D). Custom SQL use
Catalog can still detect field usage through metadata lineage; Custom SQL does NOT hide workbook dependency.
Thus, only Option C logically explains the scenario.
* Data Catalog lineage rules: "Connected vs. Impacted" distinction.
* Field-level impact analysis documentation.
* Workbook dependency logic within Tableau Catalog.

質問  # 31
......

Salesforce資格試験はそんなに難しいのですか？弊社の資料を利用したら、Analytics-Con-301試験は簡単になりま
す。お客様に最高のSalesforce問題集を入手させるために、我々は常に問題集の質を改善し、ずっと最新の試験
のシラバスに応じて問題集を更新しています。我々のAnalytics-Con-301問題集の解答を暗記すれば、お客様は必
ずこの試験に合格することができます。

Analytics-Con-301試験勉強攻略 : https://www.japancert.com/Analytics-Con-301.html

Analytics-Con-301受験資料更新版 � Analytics-Con-301前提条件 � Analytics-Con-301日本語版復習資料 �
サイト☀ www.mogiexam.com �☀�で{ Analytics-Con-301 }問題集をダウンロードAnalytics-Con-301受験トレー
リング

https://www.goshiken.com/Salesforce/Analytics-Con-301-mondaishu.html
https://www.japancert.com/Analytics-Con-301.html
https://www.mogiexam.com/Analytics-Con-301-exam.html


Analytics-Con-301関連合格問題 � Analytics-Con-301資格練習 � Analytics-Con-301資格練習 � サイト⇛
www.goshiken.com ⇚で� Analytics-Con-301 �問題集をダウンロードAnalytics-Con-301参考書勉強
試験の準備方法-有難いAnalytics-Con-301問題無料試験-真実的なAnalytics-Con-301試験勉強攻略 � ➥
Analytics-Con-301 �を無料でダウンロード（ www.xhs1991.com ）ウェブサイトを入力するだけAnalytics-
Con-301模擬試験
Analytics-Con-301日本語資格取得 � Analytics-Con-301日本語版復習資料 � Analytics-Con-301復習教材 �
➤ www.goshiken.com �に移動し、� Analytics-Con-301 �を検索して、無料でダウンロード可能な試験資料を
探しますAnalytics-Con-301模擬試験
権威のあるAnalytics-Con-301問題無料一回合格-素晴らしいAnalytics-Con-301試験勉強攻略 � 最新✔
Analytics-Con-301 �✔�問題集ファイルは➽ www.passtest.jp �にて検索Analytics-Con-301無料試験
検証するAnalytics-Con-301問題無料試験-試験の準備方法-信頼的なAnalytics-Con-301試験勉強攻略 � 検索
するだけで⇛ www.goshiken.com ⇚から▷ Analytics-Con-301 ◁を無料でダウンロードAnalytics-Con-301受験ト
レーリング
Analytics-Con-301基礎訓練 � Analytics-Con-301日本語版復習資料 � Analytics-Con-301日本語認定対策 �
� jp.fast2test.com �サイトにて▶ Analytics-Con-301 ◀問題集を無料で使おうAnalytics-Con-301前提条件
Analytics-Con-301関連合格問題 � Analytics-Con-301無料試験 � Analytics-Con-301受験資料更新版 � 「
www.goshiken.com 」にて限定無料の“ Analytics-Con-301 ”問題集をダウンロードせよAnalytics-Con-301受験資
料更新版
Analytics-Con-301試験の準備方法 | 認定するAnalytics-Con-301問題無料試験 | 検証するSalesforce Certified
Tableau Consultant試験勉強攻略 � ➠ www.goshiken.com �に移動し、▶ Analytics-Con-301 ◀を検索して、無
料でダウンロード可能な試験資料を探しますAnalytics-Con-301資格トレーニング
Analytics-Con-301資格練習 � Analytics-Con-301無料試験 � Analytics-Con-301資格認証攻略 � URL ➤
www.goshiken.com �をコピーして開き、☀ Analytics-Con-301 �☀�を検索して無料でダウンロードしてくだ
さいAnalytics-Con-301資格認証攻略
Salesforce Analytics-Con-301 Exam | Analytics-Con-301問題無料 - あなたにとって最も信頼できるウェブサイト
� � www.xhs1991.com �で✔ Analytics-Con-301 �✔�を検索して、無料で簡単にダウンロードできます
Analytics-Con-301模擬試験
myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt,
myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, www.stes.tyc.edu.tw, www.stes.tyc.edu.tw,
www.stes.tyc.edu.tw, www.stes.tyc.edu.tw, www.stes.tyc.edu.tw, www.stes.tyc.edu.tw, myportal.utt.edu.tt,
myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt,
myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, www.stes.tyc.edu.tw, www.stes.tyc.edu.tw,
Disposable vapes

P.S.JapancertがGoogle Driveで共有している無料の2026 Salesforce Analytics-Con-301ダン
プ：https://drive.google.com/open?id=1aeA_ROQDuOl8L-pwpoQvMRFyJhpXb9Na
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